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60 second countdown timer for powerpoint

The best thing about PowerPoint is that it allows you to customize your presentations as much as you need. Graphs, charts, personalized backgrounds, you name it! And of course, this includes adding time countdown tools. Here you’ll find how to easily add a free countdown timer in your PowerPoint presentations. You can even make your very own
PowerPoint timers!Adding a PowerPoint countdown timer can be a really useful tool when doing presentations. A timer can help you and your audience be aware of how much time has passed. Timers are particularly useful if you have a time limit you need to be aware of. For example, if you have a specific amount of time you can use for each slide. Or if you
are quizzing your audience, a countdown timer in the presentation will help them be aware of how much time they have left to answer your questions. You can even use them for a break in your presentation to make sure your audience knows exactly when they’re expected to be back in their seats.Free PowerPoint Countdown Timer Add-insThe easiest way
to add a free countdown timer to your presentation is through a PowerPoint add-in. Add-ins are specific, customizable tools you can add to your PowerPoint default toolbar. You’ll find add-ins for personalized graphs, design ideas, productivity tools, and so on. And of course, you’ll find many add-ins that offer the feature of adding a PowerPoint countdown
timer for your presentation.You just need to open PowerPoint and go to the Insert ribbon > Get Add-ins. This will take you directly to the Add-in store of Microsoft Office. Once there, you just need to type “timer” in the search bar, and you’ll get all the options PowerPoint has to offer.There are many options from where to chose, and you can pick whichever fits
best your own needs. My personal favorites are EasyTimer and Breaktime.PowerPoint Timers Add-in RecommendationsEasyTimer offers three different options for PowerPoint countdown timers: a square analog clock, a digital one, and a bar countdown timer. Just as it names says, it’s very easy to use, and you just need to add your time. You can also
customize if you want a ticking noise as the seconds pass by, and time’s up alarm.Breaktime is ideal for those looking for a PowerPoint countdown timer for a presentation’s break. Just as Easy Timer, you just need to type in how much time you want to countdown. The best thing about Breaktime is that you can add to your timer a themed background. It
offers different design options, like coffee, books, and lunch. Even if you can’t customize your own backgrounds, it’s still a good option to have compared to EasyTimer’s all-white default background.The only downside of these options is that they’re not very customizable. If you have an amazing PowerPoint design, these presentation timers will probably
don’t fit very well. If you want a truly customized feature, chances are, you are going to have to do it yourself. Luckily making your own PowerPoint countdown timer from scratch is very easy!Create Your Own PowerPoint TimersMaking your own PowerPoint countdown timer is easier than you might think. You just need to add your timer’s shape and use the
Animation Tab! Here you’ll find two different models of PowerPoint timers that are very easy to do on your own.Bar PowerPoint Countdown TimerA bar PowerPoint timer is one of the easiest and most effective ways to convey passing time. You just need to follow these easy instructions:1. Create the timer shape baseGo to the slide you want to add a
PowerPoint and draw your bar wherever you want your bar to be. Take into consideration that it’ll look cleaner if the end of the timer (where it’ll disappear towards) fits the border of the slide. Use the Insert tab > Shape > Rectangle to draw it.2. Add movementSelect the shape and go to the Animations Tab. Select Add Animation, and pick the Fly Out option on
the “Exit” group.3. Make it look like a timer!Now it’s time to customize the animation so it looks like a countdown timer! On the Animation Tabs, click Effect Options. Here you’ll be able to choose in which direction you want your timer to disappear. If it’s a vertical bar, To Bottom is your pick! In the case of a horizontal bar PowerPoint timer, select “To Left” or “To
Right” as you prefer.4. Customize your timer’s durationFinally, let’s add the time. On the far right of the Animation Tab, on the “Timing” group, type into Duration how much time you want your timer to countdown. And now you have a customized PowerPoint countdown timer!Make sure to check out that its start cue is On click (also in the “Timing” group”) so
you can control exactly when the countdown begins. If any of these options are unavailable when you’re trying to follow these instructions, then you might not have your shape selected. Just click on your rectangle and try again!Clock PowerPoint Countdown TimerMaking a clock PowerPoint countdown timer is very similar to the bar one, and it’s also very
easy.1. Pick your timer base shapeFirst, you need to pick the shape that’s going to work as your countdown clock. Take into consideration that it needs to be a shape, not an image. You need to be able to select only the inner circle of the clock (or the part you want to shade), in order to make it work.You can also use an icon for this. Templates by 24Slides
offer a wide array of icons you can download completely for free. There are hundreds of templates, so you’ll definitely find something that fits your needs!2. Pick your timer’s colorSelect your shape and use the Shape Format Tab > Shape Fill to add color to it. This is how your countdown clock will look when time’s up.3. Add movementWhile still selecting your
shape, go to the Animations Tab > Add Animation > Wheel option in the “Entrance” group”.4. Customize your timer’s durationNow all you need is to type your time in Duration (On the Animation Tab > “Timing” group), just like in the bar PowerPoint timer.It should end up looking something like this:And you’re all set! A completely customizable PowerPoint
countdown timer made from scratch! For those of you who want to improve your success at gaining control back to class after group activities, I have attached a 60-second countdown powerpoint.  This was readily available on one of the TES forums some time ago and I often use it if I want to increase classroom learning activities but when time-wasting is
not an option.  Use a 5-minute and 2-minute verbal ‘warning’, then the 60 seconds should be just enough time to bring things to a close.  Please feel free to use and share this document. Alternatively, you could try using egg timers for those groups who'd prefer to manage their own time. Click here >>> 60_second_countdown to download into a new window.
PP timer let’s you add a countdown timer into your PowerPoint slides! Count down from 60 minutes, or from 15 minutes and 30 seconds, or… whatever you want! The countdown can be displayed as an analog countdown clock, or as a digital countdown timer. With PP Timer you can let your audience know how much time there is left. Give your students a
10 minute task or start a 5 minute brainstorm with a management team. PP Timer works directly in your PowerPoint presentation! Need a countdown timer for Powerpoint? PP Timer is what you need! A PowerPoint countdown timer is an effective way to display a countdown clock for meeting breaks, interactive exercises, or even the beginning of a speaking,
training, or workshop session. Creating a PowerPoint presentation with countdown timer slides is easy or download these PowerPoint countdown timers to use.Download a PowerPoint Countdown TimerWant to start using a countdown timer right now? Just choose from a variety of countdown clocks you can download. And, find out how to use these timers.
Or read below to find out how to create your own custom PowerPoint countdown timer.High-tech digital countdown timer (minutes & seconds):Widescreen (16×9)Standard Screen (4×3) Countdown timer (minutes only):How to use these PowerPoint countdown timer files: These PowerPoint countdown clock presentations are saved with the PowerPoint slide
show format (.ppsx) so they can be opened quickly in the slide show view. For easy use, I copy the file to my desktop so I don’t have to navigate to folders to find it. Then, just double-click on the file, and the presentation launches automatically.Adding a Countdown Timer to Your PresentationsIf you want to move directly to the countdown timer while
delivering a presentation, copy the countdown timer into your presentation:Launch PowerPoint and open the primary PowerPoint presentation where you want to add the countdown timer slides.Next, open the countdown clock presentation file. Because these timer files are saved as PowerPoint shows, you can’t “open” the file by double-clicking on the file
name; this action runs the show. Instead, use PowerPoint’s File > Open command and navigate to the location of the file. Or press [Ctrl] + O for Open.From the Slide Sorter view, select each of the slides in the countdown timer you want to bring into the primary presentation. To select all, press [Ctrl] + A. Or hold down [Ctrl] while selecting slides
individually.Next, copy the selected timer slides by pressing [Ctrl] + C or pick Copy from the Home tab or right-click on a selected slide to pick Copy from the shortcut menu.Switch to the primary presentation and move to the Slide Sorter view. Move to the location where you want to add the timer.Paste the timer slides into your PowerPoint presentation by
pressing [Ctrl] + V or pick Paste from the Home tab or right-click where you want to insert the selected slides and pick Paste from the shortcut menu.By default, the copied slides will take on the appearance of the primary PowerPoint presentation. To keep the source formatting and maintain the appearance of the timer slides, look for the Paste Options button.
Click on the drop-down arrow and pick Keep Source Formatting.Changing the Color of Your PowerPoint Countdown TimerFollow these steps if you’d like to change the color or background of one of these PowerPoint countdown clocks:Launch PowerPoint and open the countdown timer file you want to change. As detailed above, because these timer files are
saved as PowerPoint shows (.ppsx), you can’t “open” the file by double-clicking on the file name; this action runs the show. Instead, use PowerPoint’s File > Open command and navigate to the location of the file. Or press [Ctrl] + O for Open. Save the presentation with a new name before applying new formatting.Switch to the Slide Sorter view to make it
easier to see the slides. If you want to change the color or background of all of the slides, you don’t need to select the slides. If you’ve added the timer slides to a larger presentation, hold down [Ctrl] while selecting slides individually.Next, move to the Design tab. Although this is likely too dramatic for your timer, one option is to pick a different theme from the
Themes group. To change the background color, select Format Background from the Customize group.To change the color of the numbers of the digital countdown timers, click on the drop-down arrow (More) in the Variants group and choose Colors to select from different theme color combinations. You can even customize your own. Depending on your
color choices, you may need to manually change the color of the text in the ending slide.How can you use these PowerPoint countdown timers in your next presentation?Creating Your Own Countdown TimerFollow these steps to create your own custom PowerPoint countdown timer to match your corporate template or branding or save time and download a
countdown clock.These how-to steps for creating a PowerPoint countdown clock work in Microsoft PowerPoint 365, 2019, 2016, 2013 or 2010 for Windows.To begin, create a new presentation in PowerPoint and insert a blank slide. Or insert a blank slide in an existing presentation. Edit the Slide Master or slide design to customize the background as
desired.Choose Insert > Text Box and draw a text box on your slide. Next, type the number ‘1’ or ’01’ or ‘001’ depending on how many digits you want your counter to display. Center the text, change the font style, and increase the font to a large size. Improve your countdown timer by experimenting with slide backgrounds, transitions, animations, font color
and style, etc. to create a unique look. Add images or text such as “Minutes Left” or “Seconds Remaining.”To automatically advance each slide by a set time period, choose Transition tab > Timing group > Advance Slide to apply a slide transition. Set the advance to the desired interval (1 second, 1 minute, etc.).Now that you have a master slide with the
timings set, choose View > Slide Sorter and click the formatted timer slide. Right-click on the slide and left-click on Duplicate (you can also copy and paste the original slide). The Duplicate keyboard shortcut, [Ctrl]+D also works. Repeat as many times as you want to create the sequential slides for the countdown timer.For each of the consecutive slides, edit
the countdown number until the last slide contains the ending countdown number.Insert a concluding slide with text such as “Finished” or “Time’s Up!” Optionally, add a blank, black slide at the end.For an easier and more professional display, save your presentation as a PowerPoint Show. Choose File > Save As and change the Save as type to PowerPoint
Show. This format automatically launches the slide show without opening PowerPoint. Tip: Copy your show file to the desktop for easy access.Enhance your presentations and improve your breaks and workshop exercises by adding a PowerPoint countdown timer.Were these PowerPoint tips helpful? Discover more PowerPoint techniques and shortcuts
TheSoftwarePro.com/PowerPoint.By Dawn Bjork, MCT, MOSM, CVP, The Software Pro® Microsoft Certified Trainer, Productivity Speaker, Certified Virtual Presenter is there a countdown timer in powerpoint. can you put a countdown timer in powerpoint. can you insert a countdown timer into powerpoint
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